Chapter 863

Tests for the Interaction Odds Ratio in Logistic Regression with Two Binary X’s (Wald Test)

Introduction

Logistic regression expresses the relationship between a binary response variable and one or more independent variables called \textit{covariates}. This procedure is for the case when there are two binary covariate (X and Z) and their interaction in the logistic regression model and a Wald test of the interaction is used. Often, Y is called the \textit{response} variable, the first binary covariate, X, is referred to as the \textit{exposure} variable and the second binary covariate, Z, is referred to as the \textit{confounder} variable. For example, Y might refer to the presence or absence of cancer and X might indicate whether the subject smoked or not, and Z is the presence or absence of a certain gene.

Power Calculations

Using the \textit{logistic model}, the probability of a binary event is

\[
\Pr(Y = 1|X, Z) = \frac{\exp(\beta_0 + \beta_1 X + \beta_2 Z + \beta_3 XZ)}{1 + \exp(\beta_0 + \beta_1 X + \beta_2 Z + \beta_3 XZ)}
\]

This formula can be rearranged so that it is linear in X as follows

\[
\log\left(\frac{\Pr(Y = 1|X, Z)}{1 - \Pr(Y = 1|X, Z)}\right) = \beta_0 + \beta_1 X + \beta_2 Z + \beta_3 XZ
\]

Note that the left side is the logarithm of the odds of a response event (Y = 1) versus a response non-event (Y = 0). This is sometimes called the \textit{logit} transformation of the probability. In the logistic regression model, the magnitude of the relationship between interaction and the response Y is represented by the slope $\beta_3$. 

© NCSS, LLC. All Rights Reserved.
The logistic regression model defines the baseline probability

\[ P_0 = \Pr(Y = 1|X = 0, Z = 0) = \frac{\exp(\beta_0)}{1 + \exp(\beta_0)} \]

The significance of the slope \( \beta_3 \) is commonly tested with the Wald test

\[ z = \frac{\hat{\beta}_3}{s_{\hat{\beta}_3}} \]

It is considered good practice to base the power analysis on the same test statistic that is used for analysis, so we base our power analysis on the above Wald test.

Demidenko (2008) gives the following formula for the power of the two-sided Wald test in this as

\[ \text{Power} = \Phi\left( -z_{1-\alpha} \frac{\beta_3\sqrt{N}}{\sqrt{V}} \right) + \Phi\left( -z_{1-\alpha} \frac{\beta_3\sqrt{N}}{\sqrt{V}} \right) \]

where \( z \) is the usual quantile of the standard normal distribution and \( V \) is calculated as follows.

Let \( p_x \) be the probability that \( X = 1 \) in the sample. Similarly, let \( p_z \) be the probability that \( Z = 1 \) in the sample.

Define the relationship between \( X \) and \( Z \) as a logistic regression as follows

\[ \Pr(X = 1|Z) = \frac{\exp(y_0 + y_1Z)}{1 + \exp(y_0 + y_1Z)} \]

The value of \( y_0 \) is found from

\[ \exp(y_0) = \frac{Q + \sqrt{Q^2 + 4p_x(1-p_x)\exp(y_1)}}{2(1-p_x)\exp(y_1)} \]

\[ Q = p_x(1 + \exp(y_1)) + p_z(1 - \exp(y_1)) - 1 \]

The information matrix for this model is

\[ I = \begin{bmatrix} L + F + J + R & F + R & J + R & R \\ F + R & F + R & R & R \\ J + R & R & J + R & R \\ R & R & R & R \end{bmatrix} \]

where

\[ L = \frac{(1-p_z)\exp(\beta_0)}{(1 + \exp(y_0))(1 + \exp(\beta_0))^2} \]

\[ R = \frac{p_x\exp(\beta_0 + \beta_1 + \beta_2 + \beta_3 + y_0 + y_1)}{(1 + \exp(y_0 + y_1))(1 + \exp(\beta_0 + \beta_1 + \beta_2 + \beta_3))^2} \]

\[ F = \frac{(1-p_z)\exp(\beta_0 + \beta_1 + y_0)}{(1 + \exp(y_0))(1 + \exp(\beta_0 + \beta_1))^2} \]

\[ J = \frac{p_x\exp(\beta_0 + \beta_2)}{(1 + \exp(y_0 + y_1))(1 + \exp(\beta_0 + \beta_2))^2} \]

The value of \( V \) is the (4,4) element of the inverse of \( I \).
The values of the regression coefficients are input as $P_0$ and the following odds ratio as follows:

\[
\begin{align*}
OR_{int} &= \exp(\beta_3) \\
OR_{xy} &= \exp(\beta_1) \\
OR_{yz} &= \exp(\beta_2) \\
OR_{xz} &= \exp(\gamma_1)
\end{align*}
\]

### Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

### Design Tab

The Design tab contains most of the parameters and options that you will be concerned with.

#### Solve For

This option specifies the parameter to be solved for from the other parameters. The parameters that may be selected are **Alpha**, **Power**, **Sample Size**, or **ORint**. Select **Sample Size** when you want to calculate the sample size needed to achieve a given power and alpha level. Select **Power** when you want to calculate the power of an experiment.

#### Test

**Alternative Hypothesis**

Specify whether the test is one-sided or two-sided. When a two-sided hypothesis is selected, the value of alpha is halved. Everything else remains the same.

Commonly, accepted procedure is to use the Two-Sided option unless you can justify using a one-sided test.

#### Power and Alpha

**Power**

This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. A type-II error occurs when you fail to reject the null hypothesis of equal probabilities of the event of interest when in fact they are different.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Tests for the Interaction Odds Ratio in Logistic Regression with Two Binary X's (Wald Test)

**Alpha**
This option specifies one or more values for the probability of a type-I error (alpha). A type-I error occurs when you reject the null hypothesis of equal probabilities when in fact they are equal.

Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as $0.01 \ 0.05 \ 0.10$ or $0.01 \ to \ 0.10 \ by \ 0.01$.

**Sample Size**

**N (Sample Size)**
This option specifies the total number of observations in the sample. You may enter a single value or a list of values.

**Baseline Probability**

**P0 [Pr(Y = 1 | X = 0, Z = 0)]**
This gives the value of the baseline probability of a response, P0, when neither the exposure nor confounder are present.

P0 is a probability, so it must be between zero and one.

**Odds Ratios**

**ORint (X,Z Interaction Odds Ratio)**
Specify one or more values of the Odds Ratio of the interaction X and Z, a measure of the effect size (event rate) that is to be detected by the study. Under the null hypothesis, this value is 1. This is the value under the alternative hypothesis.

You can enter a single value such as 1.5 or a series of values such as 1.5 2.5 or 0.5 to 0.9 by 0.1.

The range of this parameter is $0 < ORint < \infty$ (typically, $0.1 < ORint < 10$). Since this is the value under alternative hypothesis, $ORint \neq 1$.

**ORyx (Y,X Odds Ratio)**
Specify one or more values of the Odds Ratio of Y and X, a measure of the effect size (event rate) that is to be detected by the study. This is the ratio of the odds of the outcome Y given that the exposure X = 1 to the odds of Y = 1 given X = 0.

You can enter a single value such as 1.5 or a series of values such as 1.5 2.5 or 0.5 to 0.9 by 0.1.

The range of this parameter is $0 < ORyx < \infty$ (typically, $0.1 < ORyx < 10$).

**ORyz (Y,Z Odds Ratio)**
Specify one or more values of the Odds Ratio of Y and Z, a measure of the relationship between Y and Z. This is the ratio of the odds of the outcome Y given that the exposure Z = 1 to the odds of Y = 1 given Z = 0.

You can enter a single value such as 1.5 or a series of values such as 1.5 2.5 or 0.5 to 0.9 by 0.1.

The range of this parameter is $0 < ORyz < \infty$ (typically, $0.1 < ORyz < 10$).
**ORxz (X,Z Odds Ratio)**
Specify one or more values of the Odds Ratio of X and Z, a measure of the relationship between X and Z. This is the ratio of the odds of the exposure X given that the confounder Z = 1 to the odds that X = 1 given Z = 0.

You can enter a single value such as 1.5 or a series of values such as 1.5 2 2.5 or 0.5 to 0.9 by 0.1.

The range of this parameter is $0 < \text{OR}_{xz} < \infty$ (typically, $0.1 < \text{OR}_{xz} < 10$).

---

**Prevalences**

**Percent with X = 1**
This is the percentage of the sample in which X = 1. It is often called the prevalence of X.

You can enter a single value or a range of values. The permissible range is 1 to 99.

**Percent with Z = 1**
This is the percentage of the sample in which Z = 1. It is often called the prevalence of Z.

You can enter a single value or a range of values. The permissible range is 1 to 99.
Example 1 – Sample Size for Various Odds Ratios

A study is to be undertaken to study the occurrence of a certain type of cancer (response variable), the presence of a certain food in the diet, the presence of a certain gene, and the interaction of these two covariates. The main interest is in testing the interaction.

The baseline cancer event rate is 5%. The researchers want a sample size large enough to detect an interaction odds ratio of 2, 3, and 4 with 80% power at the 0.05 significance level with a two-sided Wald test. They want to look at the sensitivity of the analysis to the specification of the ORyx, so they also want to obtain the results ORyx = 1 2 if ORyz = 1.5. They want to study the case when X and Z are independent, that is, when ORxz = 1.5. The researchers determine that about 40% of the sample eat the food being studied. They also determine that about 25% will have the gene of interest.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Tests for the Interaction Odds Ratio in Logistic Regression with Two Binary X’s (Wald Test) procedure. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Power</td>
<td>0.80</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>P0 (\Pr(Y=1</td>
<td>X=0, Z=0))</td>
</tr>
<tr>
<td>ORint (X, Z Interaction Odds Ratio)</td>
<td>2 3 4</td>
</tr>
<tr>
<td>ORyx (Y, X Odds Ratio)</td>
<td>1 2</td>
</tr>
<tr>
<td>ORyz (Y, Z Odds Ratio)</td>
<td>1.5</td>
</tr>
<tr>
<td>ORxz (X, Z Odds Ratio)</td>
<td>1.5</td>
</tr>
<tr>
<td>Percent with X = 1</td>
<td>40</td>
</tr>
<tr>
<td>Percent with Z = 1</td>
<td>25</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power</th>
<th>N</th>
<th>Percent</th>
<th>Percent</th>
<th>P0</th>
<th>ORint</th>
<th>ORyx</th>
<th>ORyz</th>
<th>ORxz</th>
<th>Alpha</th>
<th>Beta</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.8001</td>
<td>4959</td>
<td>40.0</td>
<td>25.0</td>
<td>0.05</td>
<td>2.00</td>
<td>1.00</td>
<td>1.50</td>
<td>1.50</td>
<td>0.05</td>
<td>0.1999</td>
</tr>
<tr>
<td>0.8002</td>
<td>1863</td>
<td>40.0</td>
<td>25.0</td>
<td>0.05</td>
<td>3.00</td>
<td>1.00</td>
<td>1.50</td>
<td>1.50</td>
<td>0.05</td>
<td>0.1998</td>
</tr>
<tr>
<td>0.8002</td>
<td>1542</td>
<td>40.0</td>
<td>25.0</td>
<td>0.05</td>
<td>3.00</td>
<td>2.00</td>
<td>1.50</td>
<td>1.50</td>
<td>0.05</td>
<td>0.1998</td>
</tr>
<tr>
<td>0.8000</td>
<td>1136</td>
<td>40.0</td>
<td>25.0</td>
<td>0.05</td>
<td>4.00</td>
<td>1.00</td>
<td>1.50</td>
<td>1.50</td>
<td>0.05</td>
<td>0.2000</td>
</tr>
<tr>
<td>0.8004</td>
<td>956</td>
<td>40.0</td>
<td>25.0</td>
<td>0.05</td>
<td>4.00</td>
<td>2.00</td>
<td>1.50</td>
<td>1.50</td>
<td>0.05</td>
<td>0.1996</td>
</tr>
</tbody>
</table>
Tests for the Interaction Odds Ratio in Logistic Regression with Two Binary X's (Wald Test)

Report Definitions
Logistic regression equation: \[ \log\left(\frac{P}{1-P}\right) = \beta_0 + \beta_1 X + \beta_2 Z + \beta_3 X \times Z, \] where \( P = \Pr(Y = 1|X, Z) \) and \( X \) and \( Z \) are binary.

- Power is the probability of rejecting a false null hypothesis.
- \( N \) is the sample size.
- \( P_0 \) is the response probability at \( X = 0, Z = 0 \). That is, \( P_0 = \Pr(Y = 1|X = 0, Z = 0) \).
- Percent \( X=1 \) is the percent of the population in which the exposure is 1.
- Percent \( Z=1 \) is the percent of the population in which the confounder is 1.
- \( \text{OR}_{\text{int}} = \exp(\beta_3) \) is the odds ratio of the interaction. This is the effect size.
- \( \text{OR}_{\text{yx}} = \exp(\beta_1) \) is the odds ratio of \( Y \) versus \( X \).
- \( \text{OR}_{\text{yz}} = \exp(\beta_2) \) is the odds ratio of \( Y \) versus \( Z \).
- \( \text{OR}_{\text{xz}} \) is the odds ratio of \( X \) versus \( Z \) in a logistic regression of \( X \) on \( Z \).
- Alpha is the probability of rejecting a true null hypothesis.
- Beta is the probability of accepting a false null hypothesis.

Summary Statements
A logistic regression of a binary response variable (\( Y \)) on a binary independent variable (\( X \)) and a binary confounder variable (\( Z \)) with a sample size of 4959 observations achieves 80% power at a 0.050 significance level to detect the \( X-Z \) interaction odds ratio of 2.000. Other odds ratio settings are \( \text{OR}_{\text{yx}} = 1.000, \text{OR}_{\text{yz}} = 1.500, \text{OR}_{\text{xz}} = 1.500 \), and \( P_0 \) (prevalence of \( Y \) given \( X = 0 \) and \( Z = 0 \)) = 0.050. The prevalence of \( X \) is 40.0% and the prevalence of \( Z \) is 25.0%.

Calculations assume that a two-sided Wald test is used.

This report shows the required sample size for each of the scenarios.

Plot Section

N vs ORint by ORyx

\[ \text{OR}_{\text{yx}} = 1.00 \quad \text{OR}_{\text{yx}} = 2.00 \]
These plots show the sample size versus the odds ratio for several scenarios.
Example 2 – Validation for a Binary Covariate using Demidenko (2008)

Demidenko (2008), page 41, gives an example in which alpha = 0.05, power = 0.8, ORyx = 1, ORyz = 1, ORxz = 1, P0 = 0.5, percent X = 1 is 40, and percent Z = 1 is 25. For ORint = 2, 3, 4, 5, and 10, N = 1534, 665, 455, 366, and 252. Because the article only gives a graph which allows only approximate values, we calculated the exact values using Demidenko’s website: www.dartmouth.edu/~eugened/power-samplesize.php. We will validate this routine by running the same problem.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Tests for the Interaction Odds Ratio in Logistic Regression with Two Binary X’s (Wald Test) procedure. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Power</td>
<td>0.80</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>P0 (Pr(Y=1</td>
<td>X=0, Z=0))</td>
</tr>
<tr>
<td>ORint (X, Z Interaction Odds Ratio)</td>
<td>2 3 4 5 10</td>
</tr>
<tr>
<td>ORyx (Y, X Odds Ratio)</td>
<td>1</td>
</tr>
<tr>
<td>ORyz (Y, Z Odds Ratio)</td>
<td>1</td>
</tr>
<tr>
<td>ORxz (X, Z Odds Ratio)</td>
<td>1</td>
</tr>
<tr>
<td>Percent with X = 1</td>
<td>40</td>
</tr>
<tr>
<td>Percent with Z = 1</td>
<td>25</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

### Numeric Results for Two-Sided Wald Test

Alternative Hypothesis: ORint ≠ 1

<table>
<thead>
<tr>
<th>Power</th>
<th>N</th>
<th>Percent X=1</th>
<th>Percent Z=1</th>
<th>P0</th>
<th>ORint</th>
<th>ORyx</th>
<th>ORyz</th>
<th>ORxz</th>
<th>Alpha</th>
<th>Beta</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.8001</td>
<td>1534</td>
<td>40.0</td>
<td>25.0</td>
<td>0.50</td>
<td>2.000</td>
<td>1.000</td>
<td>1.000</td>
<td>1.000</td>
<td>0.050</td>
<td>0.1999</td>
</tr>
<tr>
<td>0.8001</td>
<td>665</td>
<td>40.0</td>
<td>25.0</td>
<td>0.50</td>
<td>3.000</td>
<td>1.000</td>
<td>1.000</td>
<td>1.000</td>
<td>0.050</td>
<td>0.1999</td>
</tr>
<tr>
<td>0.8001</td>
<td>455</td>
<td>40.0</td>
<td>25.0</td>
<td>0.50</td>
<td>4.000</td>
<td>1.000</td>
<td>1.000</td>
<td>1.000</td>
<td>0.050</td>
<td>0.1999</td>
</tr>
<tr>
<td>0.8007</td>
<td>367</td>
<td>40.0</td>
<td>25.0</td>
<td>0.50</td>
<td>5.000</td>
<td>1.000</td>
<td>1.000</td>
<td>1.000</td>
<td>0.050</td>
<td>0.1993</td>
</tr>
<tr>
<td>0.8008</td>
<td>252</td>
<td>40.0</td>
<td>25.0</td>
<td>0.50</td>
<td>10.000</td>
<td>1.000</td>
<td>1.000</td>
<td>1.000</td>
<td>0.050</td>
<td>0.1992</td>
</tr>
</tbody>
</table>

PASS matches Demidenko’s results except for ORint = 5. In this case N = 367 was required to achieve at least 0.8 power as specified.